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About this document

This document describes the graphical user interface and tasks of the 
MDMWeb software. 

The following topics are discussed in this section:

• “Who should read this document and why” (page 11)

• “What you need to know” (page 11)

• “How this guide is organized” (page 12)

• “What’s new in this document” (page 12)

• “Text conventions” (page 13)

• “Mouse button functions” (page 14)

• “Related documents” (page 14)

Who should read this document and why
This document is intended for those who use the Nortel Networks MDMWeb 
software application. This guide describes MDMWeb software capabilities 
and details the MDMWeb graphical user interface.

What you need to know
This document assumes knowledge in the following areas:

• Preside Multiservice Data Manager (MDM) 

• Sun Solaris operating system
Preside MDM MDMWeb User Guide   14.3RSUP
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• the MDMWeb client operating system, for example Windows 2000 or 
Windows NT

• Java scripts and applications

How this guide is organized
The information in this guide is organized as follows: 

• “Introduction” (page 15) provides an overview of MDMWeb software 
and its capabilities.

• “MDMWeb desktops” (page 21) provides a description of the available 
MDMWeb desktops. 

• “Getting started with MDMWeb client” (page 27) describes the 
MDMWeb graphical user interface and how to start the MDMWeb client.

• “MDMWeb alarm display” (page 45) describes the MDMWeb alarm 
display application.

• “MDMWeb command console” (page 61) describes the MDMWeb 
command console application.

• “MDMWeb network status” (page 71) describes the MDMWeb network 
status application.

• “MDMWeb network browser” (page 77) describes the MDMWeb 
network browser.

• “MDMWeb component information viewer” (page 81) describes the 
MDMWeb component information viewer application.

• “MDMWeb error messages” (page 99) provides a list of MDMWeb error 
messages and their remedial actions.

What’s new in this document
The following feature was added to this document:

• “MDM Shelf View Enhancements” (page 12)

MDM Shelf View Enhancements
All references to ccagent in this document have been replaced with psvagent. 
Psvagent has chaned to a full-time server and incorporates ccagent 
functionality.
241-6001-030   14.3RSUP   
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Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE, lowercase

In Preside Multiservice Data Manager (MDM), uppercase and lowercase 
letters that appear in UNIX commands and parameters must be matched 
exactly. The system matches upper and lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.
Preside MDM MDMWeb User Guide   14.3RSUP
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• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /)

Mouse button functions
This documentation assumes default mouse button settings. The default 
functionality and relative position of these buttons are as follows:

• select, or left, mouse button
Use this button for such tasks as selecting items that will be subject to 
further action.

• modify, or middle, mouse button
Use this button for such tasks as drag and drop operations.

• menu, or right, mouse button
Use this button for such tasks as opening pop-up menus.

Related documents
See the following documents for related information:

• 241-6001-011 Preside MDM Fault Management User Guide

• 241-6001-117 Preside MDMWeb Installation Guide
241-6001-030   14.3RSUP   
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Chapter 1
Introduction

This section provides an overview of the MDMWeb software application and 
includes the following topics:

• “What is MDMWeb?” (page 15)

• “Benefits” (page 16)

• “MDMWeb applications” (page 17)

• “MDMWeb access options” (page 18)

• “Intranet access options” (page 19)

• “Network partitioning” (page 20)

What is MDMWeb?
MDMWeb is an add-on software application to the Nortel Networks Preside 
Multiservice Data Manager (MDM) package. MDMWeb consists of various 
applications that let you perform fault management using a common desktop 
environment. You run MDMWeb as a stand-alone application.

MDMWeb supports any network element that is supported by Preside MDM, 
including Passport, Data Packet Network (DPN), and Simple Network 
Management Protocol (SNMP) devices.

MDMWeb has a client/server architecture. The client supports multiple 
platforms that include Solaris, Windows 2000, Windows NT, and Windows 
XP; the server supports the Solaris platform.
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Benefits
MDMWeb offers the advantages of Preside Multiservice Data Manager 
(MDM) fault management plus the following:

• increased network flexibility
The MDMWeb client runs on multiple platforms including Solaris, 
Windows 2000, Windows NT, and Windows XP. As a result, there is 
greater flexibility for deploying network management stations 
throughout your organization. 

• increased network access
MDMWeb lets you perform network management from remote 
locations, for example from a remote office or from home. 

• MDM architecture
MDMWeb is built on top of MDM, providing the same reliability, 
scalability, and performance as MDM.

• MDM device support
MDMWeb supports any network element that is supported by MDM.

• flexible deployment options
MDMWeb runs from a common desktop environment as a standalone 
application.

• remote dial-in capability
MDMWeb clients can operate within a customer intranet that is LAN-
based, WAN-based, or both. Consequently, you can launch client 
applications in a network that spans different sites or regions using a 
remote dial-in facility.

•  intranet access
MDMWeb clients can operate into a customer intranet, if the appropriate 
intranet access is available.

• network partitioning
MDMWeb provides the ability to partition the network so that specific 
network segments are available to specific users. Partitioning does not 
require an MDM workstation for each partition. Rather, you can partition 
the network using a single workstation.
241-6001-030   14.3RSUP   
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• customize tools
MDMWeb clients can integrate non-MDMWeb tools into the MDMWeb 
desktop.

• alarm history information
MDMWeb gives you increased alarm history information if you choose 
to access alarm information through the real time alarm collection tool 
(RTAC).

• launching MDMWeb applications from an invisible desktop
MDMWeb applications can be launched from outside MDMWeb’s 
desktops. This enables MDMWeb applications to be integrated into the 
MDM toolset or into another management platform.

• reduced number of fixed ports
The MDMWeb agent mnsdagent is the only agent that requires a fixed 
port. The ports for the other agents are assigned dynamically.

• agent configuration
MDMWeb agents can be configured using MDM’s software 
configuration tool.

MDMWeb applications
MDMWeb software includes various applications for fault management and 
an application for browsing Nortel Networks Technical Publications (NTPs). 
The applications are as follows:

• login
automatically starts when you log into MDMWeb. Its purpose is to 
authenticate the login user ID and password

• system log display
captures trace, information, and error messages

• alarm display
displays alarms in the network, either in active alarm mode or in alarm 
log mode

• command console
establishes a group connection and directly accesses the network device 
to allow command input
Preside MDM MDMWeb User Guide   14.3RSUP
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• connection management
lets you connect to or disconnect from groups within the network

• network status
provides a high-level view of the network status including component 
states

• network browser
displays network element states and allows you to navigate the network 
hierarchy

• component information viewer
 provides state and alarm information for a specified component

• troubled components
displays devices and subcomponents in a troubled state

• server status display
displays information on the various Preside MDM servers, including 
their current state

• prefix editor
creates a prefix list for use by the Command Console application

• online documentation
 provides browsing capabilities for online documentation

MDMWeb access options
How you access and use MDMWeb depends on the following:

• the selected MDMWeb client platform 

• the selected MDMWeb deployment option

MDMWeb client platforms
Although the MDMWeb server runs on a Solaris platform, the MDMWeb 
client runs on multiple platforms. This lets you access MDMWeb from 
platforms that include Solaris, Windows 2000, Windows NT, and Windows 
XP. 
241-6001-030   14.3RSUP   
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MDMWeb deployment options
Some of the available MDMWeb client platforms offer a choice of 
deployment options. Your installation may deploy MDMWeb as a client 
application. The MDMWeb client application is a Java-based, standalone 
application. 

MDMWeb access possibilities
The following list details the possible combinations of platforms and 
deployment options that MDMWeb supports: 

• Solaris with a client application

• Windows 2000 with a client application

• Windows NT with a client application

• Windows XP with a client application

“Starting the MDMWeb client” (page 28) provides access information for 
each entry in the preceding list. Refer to the startup information that is 
relevant to the configuration at your site.

Intranet access options
You can start MDMWeb clients by using an intranet. If the LAN-based or 
WAN-based intranet spans different regions and sites, use remote acess  
applications into the intranet to connect the  client applications to the 
MDMWeb server.

The figure “Intranet access to MDMWeb” (page 20) shows access to 
MDMWeb using the intranet.
Preside MDM MDMWeb User Guide   14.3RSUP
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Figure 1
Intranet access to MDMWeb

Network partitioning
MDMWeb provides an optional feature that lets you partition the network. 
Partitioning a network makes access to specific network segments available 
to specific users. Consequently, users can focus on specific network segments 
rather than the entire network. For example, partitioning a large network by 
region lets users readily view management information for their specific 
region rather than the entire network. For details about partitioning, see 
241-6001-117 Preside MDMWeb Installation Guide.

MDMWeb server MDM server

MDMHelp  server Apache Web server

Solaris Workstation

MDMWeb client application

Intranet
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Chapter 2
MDMWeb desktops

This section provides a description of the MDMWeb desktop interface and 
contains the following topics:

• “MDMWeb client desktop interfaces” (page 21)

• “Customizing the desktop” (page 24)

MDMWeb client desktop interfaces
MDMWeb provides three client desktop interfaces:

• an integrated desktop

• a collection desktop

• an invisible desktop

An integrated desktop opens all MDMWeb applications within a single 
window. A collection desktop opens each MDMWeb application in its own 
window. An invisible desktop provides a socket which listens to incoming 
commands and executes them as though they had been executed from the 
desktop. The invisible desktop can only be used by Solaris client applications. 
There is no graphical user interface (GUI).

The figure “Integrated desktop” (page 22) shows an integrated desktop with 
the network browser, alarm display, and network status applications open. All 
applications display in a single, or integrated, window.
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Figure 2
Integrated desktop

The figure “Collection desktop” (page 23) shows a collection desktop with 
the network browser, alarm display, and network status applications open. 
Each application has its own window.
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Figure 3
Collection desktop
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Invisible desktop commands
The script sendwebcmd is used to contact the invisible desktop and send it a 
command. You can use this script with Solaris client applications only. The 
script takes on parameters of the various commands that can be sent to the 
invisible desktop. These commands include:

• LAUNCH <application name> launches an application that is defined in 
the APP <application> sections in the MDMWeb Solaris client’s 
resource file /opt/Nortel/MDMWeb/cfg/WebNMSRes.txt.

• SETCONTEXT <context> sets the invisible desktop’s current context, 
where <context> is the Hot Context. For more information, see “Hot 
context” (page 43)

• SETCOLORSCHEME <scheme> sets the invisible desktop’s color 
scheme, as defined in the COLORSCHEME <scheme> sections in the 
MDMWeb Solaris client’s resource file. 

• CHANGELOOKANDFEEL switches between Java’s metal look and 
feel and the native look and feel. Java’s metal look and feel looks the 
same across different platforms. Java’s native look and feel differs across 
platforms.

• SHOWFULL HELP launches help, and displays the full set of NTPs.

• CASCADEWINDOWS cascades the windows displayed by the desktop.

• EXIT exits the desktop.

Customizing the desktop
You can customize the MDMWeb client desktop by changing the resource 
parameters in the client resource file or by selecting options provided in the 
MDMWeb  window menu. For more information, see the following:

• “Resource file” (page 24)

• “MDMWeb window” (page 25)

Resource file
The resource file defines the resources for the following items:

• applications to load 

• images to use
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• server machine 

• MDMHelp server

• desktop colors (RGB values)

To customize the MDMWeb desktop using the resource file, change the 
default settings for items in the preceding list.

The names and paths of resource files are dependent upon the platform you 
use. Choose the resource file that is appropriate to the platform and 
installation option you are using. 

• for a Solaris client application, edit the resource file
<install path>/MDMWeb/cfg/WebNMSRes.txt

• for a Windows client application, edit the resource file
<install path>/MDMWeb/cfg/WMSWinRes.txt

MDMWeb  window
The Options menu in the MDMWeb  window lets you change the default 
color scheme and the look and feel of the interface.

The color scheme represents alarm severity and component states. MDMWeb 
is delivered with two predefined color schemes—Preside Multiservice Data 
Manager (MDM) and standard. For more information about color schemes, 
see “Options” (page 33). You can select one of these color schemes, or you 
can define your own using the resource file. For more information about 
customizing the resource file, see “Resource file” (page 24).

By default the MDMWeb desktop opens with the Java Metal look and feel. 
You can use this default or you can change the default to display the look and 
feel of the platform you are using. For example, if you use a Windows 
platform, you can use the Windows look and feel rather than the Java look and 
feel.
Preside MDM MDMWeb User Guide   14.3RSUP



26   Chapter 2 MDMWeb desktops
241-6001-030   14.3RSUP   



27
Chapter 3
Getting started with MDMWeb client

This section provides details on starting the MDMWeb client and contains the 
following topics:

• “Your view of the network” (page 27)

• “Starting the MDMWeb client” (page 28)

• “MDMWeb login window” (page 30)

• “MDMWeb window” (page 31)

• “Server status display” (page 36)

• “Server Status Display window” (page 37)

• “MDMWeb System Log Display application” (page 40)

• “MDMWeb System Log Display window” (page 41)

• “MDMWeb connection management application” (page 42)

• “Hot context” (page 43)

Your view of the network
If MDMWeb is set up with partitions, the user ID that you use to log on 
determines whether you can access the entire network or one or more 
partitions within the network. For details about partitioning, see 
241-6001-117 Preside MDMWeb Installation Guide. 
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Starting the MDMWeb client
There are various methods for starting the MDMWeb client. From the 
following list, select the procedure that is applicable to your installation:

• “Solaris client application” (page 28)

• “Windows client application” (page 29)

Solaris client application
You can start the MDMWeb Solaris client application with either an 
integrated or collection desktop. For details about MDMWeb desktops, see 
241-6001-030 Preside MDMWeb User Guide. Use one of the following 
procedures.

Starting MDMWeb with an integrated desktop

1 Type the following:

<install path>/MDMWeb/webnmsi

where:

<install path> is the path to the MDMWeb file system identified 
during the MDMWeb client installation. 

Example
/opt/Nortel/MDMWeb/webnmsi

The Login on hostname window and the MDMWeb window open.

2 In the Login on hostname window,enter the hostname, User and 
Password. For details, see “MDMWeb login window” (page 30)

Starting MDMWeb with a collection desktop

1 Type the following:

<install path>/MDMWeb/webnmsc

where:

<install path> is the path to the MDMWeb file system identified 
during MDMWeb client installation. 

Example
/opt/Nortel/MDMWeb/webnmsc

The Login on hostname window and MDMWeb window open.
241-6001-030   14.3RSUP   



Chapter 3 Getting started with MDMWeb client   29
2 In the Login on hostname window, enter the User and Password. For 
details, see “MDMWeb login window” (page 30)

Starting MDMWeb with an invisible desktop

1 Type the following:

<install path>/MDMWeb/sendwebcmd <command>

where:

<install directory> is the path to the MDMWeb file system 
identified during MDMWeb client installation. 

<command> is the command you wish to launch.

Example
/opt/Nortel/MDMWeb/sendwebcmd LAUNCH ALARMBROWSER

2 The command executes.

Note:  For more information on commands, see 241-6001-030 Preside 
MDMWeb User Guide.

Windows client application
You can start the MDMWeb Windows client application with either an 
integrated or collection desktop. For details about MDMWeb desktops, see 
241-6001-030 Preside MDMWeb User Guide. 

Use one of the following procedures to start MDMWeb:

Starting MDMWeb from the Windows Start button

1 MDMWeb installation software automatically adds the MDMWeb 
collection desktop and integrated desktop icons to the Windows Start 
menu. You can use them to select the appropriate MDMWeb desktop.

Starting MDMWeb with an integrated desktop

1 Type the following:

<drive>:\<install path>\MDMWeb\
Integrated Desktop.exe

where:

<drive> is the disk or partition where MDMWeb is installed.
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<install path> is the path to the MDMWeb file system identified 
during the MDMWeb client installation. 

Example
C:\Program Files\MDMWeb\Integrated Desktop.exe

The Login on hostname window and MDMWeb window open.

2 In the Login on hostname window, enter the User and Password. For 
details, see “MDMWeb login window” (page 30).

Starting MDMWeb with a collection desktop

1 Type the following:

<drive>:\install path>\MDMWeb\
Collection Desktop.exe

where:

<drive> is the disk or partition where MDMWeb is installed.

<install path> is the path to the MDMWeb file system identified 
during the MDMWeb client installation. 

Example
C:\Program Files\MDMWeb\Collection Desktop.exe

The Login on hostname window and MDMWeb window open.

2 In the Login on hostname window, enter the User and Password. For 
details, see “MDMWeb login window” (page 30).

MDMWeb login window
When you start MDMWeb, the MDMWeb login application opens a Login 
window and the MDMWeb window. Generally, before you can use any 
MDMWeb application, you must first complete the information required by 
the Login on hostname window. One exception, however, is the System Log 
Display application. MDMWeb lets you open the System Log Display 
application before you log in. This enables you to capture all your MDMWeb 
activities in a log file, including the login procedure. For details about opening 
a log file, see “MDMWeb System Log Display window” (page 41).
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From the Login on hostname window you can either select the default server 
host or specify another server host. If you specify another server host, it must 
be a valid MDMWeb server that can be reached by the client. After 
authentication, the server host selection remains in effect for the session. 
Therefore, to change a server host you need to restart the MDMWeb client. 

When you type entries in the User and Password fields, MDMWeb 
authenticates these entries against the permissible user names and passwords 
configured during the MDMWeb installation. After authentication completes, 
you can access the various MDMWeb applications. 

The figure “MDMWeb login window” (page 31) shows the Login on 
hostname window in front of the MDMWeb window.

Figure 4
MDMWeb login window

MDMWeb window
The figure “MDMWeb window” (page 32) shows a sample MDMWeb 
window with an integrated desktop.
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Figure 5
MDMWeb window

The MDMWeb window consists of the following items:

• “Menu bar” (page 33)

• “Icon bar” (page 35)

• “Network browser area” (page 36) (integrated desktop only)

• “Network status area” (page 36) (integrated desktop only)

menu bar

icon bar

network 
browser 
area

network 
status 
area
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Menu bar
The MDMWeb window includes the following menus:

• “File” (page 33)

• “Options” (page 33)

• “Fault” (page 34)

• “System” (page 34)

• “Window” (page 35)

• “Help menu” (page 38)

File 
The File menu contains the following command: 

• Exit closes the MDMWeb session.

Options
The Options menu contains the following commands:

• Change Look & Feel By default, the MDMWeb desktop opens with the 
Java Metal look and feel. If you prefer, you can change this default to the 
look and feel of the platform you are using. Selecting the Change Look 
& Feel command toggles between the two choices for look and feel. 

• Color Scheme lets you select one of the two color schemes for state and 
alarm information:

— MDM color scheme

— Standard color scheme

The MDM and standard color schemes are shown in the table “State color 
representations for MDM and standard” (page 34). If you want to customize 
the color scheme beyond what is available from the Options menu, you must 
make these changes in the client resource file. For more information on 
customizing the resource file, see 241-6001-030 Preside MDMWeb User 
Guide.
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Fault 
The Fault menu contains the following commands: 

• Network Browser starts the network browser application.

• Alarm Display starts the alarm display application.

• Network Status starts the network status application.

• Troubled Components helps you determine which devices and 
subcomponents are experiencing problems.

• Component Information Viewer starts the component information 
viewer application.

System
The System menu contains the following submenus:

• Administration

• Utilities

• Custom

The Administration submenu contains the following commands:

• Server Status Display provides you with a view of the status of the 
agents running on the server machine. You can determine why an 
MDMWeb application is not working. For more information, see “Server 
status display” (page 36).

Table 1
State color representations for MDM and standard

MDM color scheme Standard color scheme

Color State Color State

red critical red critical

orange major red major

yellow minor orange minor

blue warning yellow warning
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• System Log Display starts the MDMWeb log application and opens the 
System Log Display window. You can log trace, information, and error 
messages. For details, see “MDMWeb System Log Display window” 
(page 41).

• Connection Management starts the connection management 
application..

• Prefix Editor opens the command console prefix editor.

The Utilities submenu contains the following command:

• Command Console starts the command console application.

The Custom submenu item only appears if you have integrated your own 
tools within MDMWeb. The commands that you define are displayed in the 
Custom menu.

To integrate your own tools, you must modify the resource file. For more 
information, see 241-6001-117 Preside MDMWeb Installation Guide.

Window
The Window menu contains the following command:

• Cascade aligns the open application windows so that they cascade down 
from the top left corner.

Help 
The Help menu contains the following commands:

• About MDMWeb displays information about the MDMWeb 
application.

• Online Documentation displays information about the help application 
for online documentation.

Icon bar
The icon bar in the MDMWeb window contains icons that launch other 
MDMWeb applications including the following:

• network browser

• alarm display
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• network status

• component information viewer

• command console

• connection management

The figure “MDMWeb window icon bar” (page 36) shows the MDMWeb 
window icon bar and the application that each icon represents.

Figure 6
MDMWeb window icon bar

Network browser area
If you start MDMWeb with the integrated desktop option, the network 
browser application automatically opens in the MDMWeb window. If you 
start MDMWeb with the collection desktop option, the network browser does 
not automatically open. 

Network status area
If you start MDMWeb with the integrated desktop option, the network status 
application automatically opens in the MDMWeb window. If you start 
MDMWeb with the collection desktop option, the network status does not 
automatically open..

Server status display
The server status display application helps you determine why an MDMWeb 
application is not working. You can look at the server list and determine 
whether the application is not working because the agent is not running. The 
server status application is similar to the Preside Multiservice Data Manager 
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(MDM) Server Administration tool, but MDMWeb does not allow you to start 
and stop servers. For details about the server status display, see “Server Status 
Display window” (page 37).

Server Status Display window
From the System menu, select Administration -> Server Status Display to 
display the Server Status Display window. 

The figure “Server Status Display window” (page 37) shows a sample of the 
Server Status Display window. 

Figure 7
Server Status Display window

The Server Status Display window contains a Refresh button that reloads 
server and status information. The information is static, so you must click 
Refresh when you want new information to load.

menu bar

server list area

detailed server information area
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The Server Status Display window consists of the following items:

• “Menu bar” (page 38)

• “Server list area” (page 38)

• “Detailed server information area” (page 39)

Menu bar
The Server Status Display window menu bar includes the following items:

• “File menu” (page 38)

• “Help menu” (page 38)

File menu
The File menu provides the following commands:

• Refresh reloads the server information.You must select this menu item 
when you want new information to load.

• Close closes the Server Status Display application.

Help menu
The Help menu provides the following commands:

• On Server Status Display displays help on the Server Status Display 
application.

• Online Documentation launches help and displays the Preside 
Multiservice Data Manager (MDM) NTPs.

Server list area
The server list area contains a list of the servers being monitored by the 
Preside Multiservice Data Manager (MDM) server daemon (SVMDMN). 
The listing contains the name of the server and its current status reflected by 
color.

Server states
A server’s state is displayed in the server lists area. Its state is also reflected 
by a color that equates to its state.

The table “Server states” (page 39) describes the server states and their 
corresponding colors.
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Detailed server information area
The detailed server information area contains information on one specific 
server. When you select a server from the server list area, the detailed server 
information area is displayed.

Server fields
The table “Server fields” (page 39) describes the fields that are displayed in 
the detailed server information area.

Table 2
Server states

State Color scheme name Default 
color

Description

Not Started SERVER_NOT_STARTED grey The server has not been started since 
the SVMDN last started monitoring 
servers, or since the server was 
added to the list of servers to manage.

Running SERVER_RUNNING green The server is running.

Exited SERVER_EXITED yellow The server has stopped for some 
reason, and is waiting to be restarted.

Quit SERVER_QUIT red The server has been stopped.

Failed SERVER_FAILED orange The server has run out of restarts.

Table 3
Server fields

Field Description

Name The name of the server.

State The server’s current state.

Startup Command The command executed to start the server.

Started The date and time the server was last started. 
This field may be blank.

 (Sheet 1 of 2)
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MDMWeb System Log Display application
The MDMWeb System Log Display application lets you capture and display 
trace, information, and error messages generated by the MDMWeb client. For 
details about the System Log Display window, see “MDMWeb System Log 
Display window” (page 41).

Stopped The date and time the server was last stopped or 
exited. This field may be blank.

Exit The return code from the server’s last exit. This 
field may be blank.

Restarts The number of times the server has stopped and 
been restarted.

Fast Restart Interval The length of time between fast restarts. A server 
is in fast restart mode when it first starts exiting.

Fast Restart Limit The number of fast restarts allowed before the 
server moves to slow restart mode.

Slow Restart Interval The length of time between slow restarts. A 
server is in slow restart mode if it is unable to 
restart after the number of attempts specified by 
the fast restart interval.

Slow Restart Limit The number of slow restarts allowed before the 
server stops trying to restart.

Stability Period The length of time a server that slow restart 
mode must run before being moved back to fast 
restart mode.

Start At Reboot If the workstation is rebooted, the server be 
restarted.

Kill Signal The signal that is sent to the server to stop it from 
running.

Permanent Entry This field is either true or false. If true, this server 
cannot be removed from the server list.

Table 3 (continued)
Server fields

Field Description

 (Sheet 2 of 2)
241-6001-030   14.3RSUP   



Chapter 3 Getting started with MDMWeb client   41
MDMWeb System Log Display window
From the System menu, select Administration -> System Log Display to 
access the System Log Display window.

The figure “System Log Display window” (page 41) shows a sample window. 

Figure 8
System Log Display window

The System Log Display window consists of the following items:

• “Menu bar” (page 41)

• “Log information check boxes” (page 42)

• “Log history area” (page 42)

Menu bar
The System Log Display window menu bar includes the following item:

• “File menu” (page 42)

menu bar

log information 
check boxes

log history area
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File menu
The File menu provides the following commands:

• Save saves the contents of the log to a file. When you select this 
command, a Java Save dialog opens and prompts you for information on 
where to save the log file.

• Log to file opens or closes a log session. To open a log session and 
capture trace, information, or error messages, select the Log to file check 
box. When you select this command, a Java Open dialog opens and 
prompts you for information on where to store the log file. After the file 
opens, messages begin accumulating. To close the log session, clear the 
Log to file check box.

• Print prints the contents of the log. When you select this command, a 
Java Print dialog opens and prompts you for information about the print 
destination for the log file.

• Close closes the MDMWeb System Log Display application.

Log information check boxes
The System Log Display window contains check boxes that you use to select 
the type of information to log. When you select a check box, the log file 
begins collecting the requested information. You can log the following types 
of information:

• Trace collects debug information.

• Info collects significant events such as connecting to, or disconnecting 
from, a server.

• Error collects messages about processes that fail to execute.

Log history area
The log history area collects information based on the selected log 
information check boxes and displays this information the log history area.

MDMWeb connection management application
You access the connection management application from

• the Security menu in the command console window
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• the security tab in the diagnostics section of the component information 
viewer

• the System -> Administration menu in the MDMWeb menu

The Connection Management window lets you connect to, or disconnect 
from, groups in the network.

Hot context
Some MDMWeb applications support hot context. Hot context is a feature 
that lets you transfer component ID information among applications that 
support filters. You can turn the hot context feature on or off, as you need. 

You set context when you select a component ID or an alarm containing a 
component ID. Therefore, context is set when you select any of the following:

• a component in the network browser

• a component in the component information viewer

• an alarm in the component information viewer

• an alarm in the alarm display 

The component ID in context then acts as an initial filter when subsequently 
opening other applications or as an override to any existing filters in 
applications already open. Although you can set context from the network 
browser, component information viewer, and alarm display, only the alarm 
display and component information viewer receive items from context. 
Preside MDM MDMWeb User Guide   14.3RSUP



44   Chapter 3 Getting started with MDMWeb client
241-6001-030   14.3RSUP   



45
Chapter 4
MDMWeb alarm display

This section describes the MDMWeb alarm display application and contains 
the following topics:

• “Alarm display overview” (page 45)

• “Alarm display window” (page 46)

• “Using filters” (page 56)

Alarm display overview
The MDMWeb alarm display application lets you view alarms in the network. 
You can display a list of alarms in log mode or active mode and you can use 
filter controls to filter the alarm list. You can also select an alarm and display 
it in full format to see more detailed information. Additionally, you can view 
alarm help for information about remedial action.

For details on the Preside Multiservice Data Manager (MDM) alarm display, 
see 241-6001-011 Preside MDM Fault Management User Guide. For a 
comparison of alarm display features in both MDM and MDMWeb, see the 
table “Comparison of MDM and MDMWeb alarm display features” 
(page 46).
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Alarm display window
You access the alarm display application from the Fault menu in the 
MDMWeb window.

The figure “MDMWeb alarm display window” (page 47) shows an example 
of an alarm display window.

Table 4
Comparison of MDM and MDMWeb alarm display features

Feature MDM 
alarm display

MDMWeb 
alarm display

Menu bar Yes Yes

Pause/Resume Yes Yes

Format Yes Yes

Print Yes Yes

Save to a file Yes Yes

Filter control - severity Yes Yes

Filter control - fault code Yes Yes

Filter control - component ID Yes Yes

Filter Control - customer IDs & Ack user ID & Ack state Yes Customer ID

Filter action - accept/reject alarms Yes Yes

Filter - wild cards Yes Yes

Save/restore filters Yes Yes

Switch to active alarms/alarm log Yes Yes

Filter on/off Yes Yes
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Figure 9
MDMWeb alarm display window

The alarm display window consists of the following areas:

• “Menu bar” (page 47)

• “Filter panel area” (page 53)

• “Alarm list area” (page 53)

• “Detail alarm panel” (page 55)

Menu bar
The alarm display provides the following menus:

• “File” (page 48)

• “View” (page 49)

menu bar

filter 
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detail 
alarm 
panel
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• “Edit” (page 49)

• “Fault” (page 50)

• “Filter” (page 50)

• “Alarms” (page 50)

• “Help” (page 53)

File 
The File menu contains the following commands:

• Save As opens a Java Save dialog and lets you save the alarm display 
information to a specified file. 

• Log Alarms To File opens or closes an alarm log session. To open a log 
session and capture incoming alarms, select the Log Alarms To File 
check box. When you select this command, a Java Open dialog opens and 
prompts you for information on where to store the log file. After the log 
file opens, alarms begin accumulating. To close the log session, clear the 
Log Alarms To File check box.

• Reset Server Connection resets the connection to the general 
management data router (GMDR) server. Use this command if the 
GMDR server stops responding to the client, for example, if you set a 
new filter but receive no alarms. 

• Print Alarm Details prints details on the currently selected alarm and 
includes the following information:

— component

— state

— time

— type

— customer ID

— fault

— severity

— cause 

— event
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— comments

— acknowledge state

— acknowledge reason

— acknowledge user ID

• Print Alarm Summary prints summary alarm information on each 
alarm in the alarm list area and includes the following information:

— alarm number

— severity

— component

— event

— date and time

• Close closes the alarm display window and exits the application.

View
The View menu contains the following command:

• Show Alarm Bubbles changes to display format of alarms. By default, 
the MDMWeb alarm display application displays alarms in Preside 
Multiservice Data Manager (MDM). If you prefer, you can display the 
alarms using the standard alarm format. The MDM format provides a 
background color for each alarm to indicate alarm severity. The standard 
alarm format uses color-coded alarm bubbles, rather than background 
colors, to indicate alarm severity. Selecting the Show Alarm Bubbles 
command toggles between the two alarm display choices.

Edit
The Edit menu contains the following command:

• Copy Alarm copies the full format of a selected alarm from the alarm 
list to the system clipboard. You can then paste this information into 
another application.
Preside MDM MDMWeb User Guide   14.3RSUP



50   Chapter 4 MDMWeb alarm display
Fault 
The Fault menu contains the following commands:

• Launch Network Browserstarts the network browser application. For 
details, see “MDMWeb network browser” (page 77).

• Launch Component Information Viewer starts the component 
information viewer application. For details, see “MDMWeb component 
information viewer” (page 81).

Filter 
The Filter menu contains the following commands:

• Simple Filter filters alarms based on a single component ID, a single 
fault code, or both. For more information, see “Simple Filter” (page 57).

• Advanced Filter filters alarms based on multiple component IDs and 
multiple fault codes. For more information, see “Advanced filter” 
(page 58).

• Save Filter opens a Java Save dialog and lets you save the currently 
selected filter to a file.

• Load Filter opens a Java Open dialog and lets you load a previously 
saved filter file. When you load a simple filter file, the alarm display 
automatically shows the simple filter. When you load an advanced filter 
file, the alarm display automatically shows the advanced filter. The filter, 
however, does not activate until you click  Set.

Alarms
The Alarms menu contains the following commands:

• Sort Alarms By Component ID sorts alarms alphabetically by 
component ID. The alarm display sorts only those alarms that are present 
at the time of the sort request. Subsequent alarms appear unsorted at the 
end of the alarm table.

• Sort Alarms By Time sorts alarms by time. The alarm display sorts only 
those alarms that are present at the time of the sort request. Subsequent 
alarms appear unsorted at the end of the alarm table.
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• Acknowledge Alarm acknowledges an alarm in the alarm list. When 
you select this command an input dialog opens and prompts you for an 
acknowledge comment. After you acknowledge an alarm, the application 
displays a check mark icon in the alarm Event field.

• Unacknowledge Alarm unacknowledges an alarm in the alarm list. 
When you select this command an Input dialog opens and prompts you 
for an unacknowledge comment. After you unacknowledge an alarm, the 
application displays a crossed out check mark icon in the alarm Event 
field.

• Show Critical Alarm Highlights turns background color (highlights) on 
or off for critical alarms. To highlight critical alarms, select the Show 
Critical Alarm Highlights check box. In Preside Multiservice Data 
Manager (MDM) alarm format, rows that contain critical alarms display 
with highlights. In the standard alarm format, critical alarm bubbles 
display with highlights. To turn off critical highlights, clear the check 
box.

• Show Major Alarm Highlights turns background color (highlights) on 
or off for major alarms. To highlight major alarms, select the Show 
Major Alarm Highlights check box. In the MDM alarm format, rows 
that contain major alarms display with highlights. In the standard alarm 
format, major alarm bubbles display with highlights. To turn off major 
highlights, clear the check box.

• Show Minor Alarm Highlights turns background color (highlights) on 
or off for minor alarms. To highlight minor alarms, select the Show 
Minor Alarm Highlights check box. In the MDM alarm format, rows 
that contain minor alarms display with highlights. In the standard alarm 
format, minor alarm bubbles display with highlights. To turn off minor 
highlights, clear the check box.

• Show Warning Alarm Highlights turns background color (highlights) 
on or off for warning alarms. To highlight warning alarms, select the 
Show Warning Alarm Highlights check box. In the MDM alarm 
format, rows that contain warning alarms display with highlights. In the 
standard alarm format, warning alarm bubbles display with highlights. 
To turn off warning highlights, clear the check box.
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• Show Indeterminate Alarm Highlights turns background color 
(highlights) on or off for indeterminate alarms. To highlight 
indeterminate alarms, select the Show Indeterminate Alarm 
Highlights check box. In the MDM alarm format, rows that contain 
indeterminate alarms display with highlights. In the standard alarm 
format, indeterminate alarm bubbles display with highlights. To turn off 
indeterminate highlights, clear the check box.

• Show Cleared Alarm Highlights turns background color (highlights) 
on or off for cleared alarms. To highlight cleared alarms, select the Show 
Cleared Alarm Highlights check box. In the MDM alarm format, rows 
that contain cleared alarms display with highlights. In the standard alarm 
format, cleared alarm bubbles display with highlights. To turn off cleared 
highlights, clear the check box.

• Critical Bell turns sound effects on or off for critical alarms. Use this 
command only if your resource file has sound definitions and your 
hardware supports sound. To play a sound whenever the alarm display 
receives a critical alarm, select the Critical Bell check box. To turn off 
sounds for critical alarms, clear the check box.

• Major Bell turns sound effects on or off for major alarms. Use this 
command only if your resource file has sound definitions and your 
hardware supports sound. To play a sound whenever the alarm display 
receives a major alarm, select the Major Bell check box. To turn off 
sounds for major alarms, clear the check box.

• Minor Bell turns sound effects on or off for minor alarms. Use this 
command only if your resource file has sound definitions and your 
hardware supports sound. To play a sound whenever the alarm display 
receives a minor alarm, select the Minor Bell check box. To turn off 
sounds for minor alarms, clear the check box.

• Warning Bell turns sound effects on or off for warning alarms. Use this 
command only if your resource file has sound definitions and your 
hardware supports sound. To play a sound whenever the alarm display 
receives a warning alarm, select the Warning Bell check box. To turn off 
sounds for warning alarms, clear the check box.
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Help 
The Help menu contains the following commands:

• On Alarm Displaydisplays online information about the alarm display 
application.

• Online Documentation opens the help application for document 
browsing.

Filter panel area
The Filter panel area is where you can use filters to display different alarm 
information or set hot context. 

By default, the filter panel is hidden. However, the alarm display window 
contains buttons that let you control the filter panel display. A message in the 
upper right corner of the filter panel area always indicates whether filtering is 
on or off. So, even if the filter panel is hidden, you can see whether filtering 
is in effect or not.

The filter panel area contains the following filter option buttons:

• Hide hides the filter panel.

• Show displays the filter panel. You can display a simple filter or an 
advanced filter. For information about the simple filter panel, see 
“Simple Filter” (page 57). For information about the advanced filter 
panel, see “Advanced filter” (page 58).

Note: In the simple and advanced filter panels, wild cards are not 
permissible in the filter entry fields.

• Filter turns on alarm filtering.

• Hot context If you select this check box, hot context is turned on. If you 
do not select this check box, hot context is turned off. For information 
about hot context, see “Hot context” (page 43).

Alarm list area
The alarm list area consists of a list box and check boxes that let you 
determine what displays in the alarm list, an alarm count, and a detailed alarm 
list. 
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Alarm mode
This list box lets you choose from the following alarm modes. 

• Active Alarms display only active alarms.

• Alarm Log displays recent alarms as they are received by Preside 
Multiservice Data Manager (MDM). This mode includes all alarms 
including set, clear, and message events

Note: The message Alarm Logging is displayed in the detail alarm panel 
section of the Alarm Display when Alarm Log is selected. The message 
indicates that alarms are being loaded.

• Alarm History is similar to Alarm Log but also includes past alarms. In 
some networks, selecting this mode can result in large amounts of alarm 
data.

The GMDR server has limited storage for alarm history information. You 
can obtain alarm history information from the real time alarm collection 
(RTAC) tool instead of the GMDR server. You need to configure the 
resource file to obtain alarms from RTAC. For more information, see one 
of the following:

— for MDMWeb client on Solaris: See the MDMWeb client 
procedures for Solaris in  241-6001-117 Preside MDMWeb 
Installation Guide

— for MDMWeb client on Windows:  See the MDMWeb client 
procedures for Windows in 241-6001-117 Preside MDMWeb 
Installation Guide

RTAC limits the alarm information to the previous 24 hours when:

• the users do not apply the alarm filter

• the users use the default value in the Alarms After Date/Time filter field 
in the Simple filter or use the default value in the Time field in the 
Advanced filter.

You can override this by specifying dates and times in the alarm display’s 
alarms filters. For more information on filters, see “Using filters” (page 56).
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Note: RTAC does not support partitioning. It always provides alarm 
history for the entire network.

Pause Alarms
If you select this check box, no subsequent alarms display in the alarm list. If 
you do not select this check box, the alarm display continues to add alarms to 
the alarm list. 

Auto-scroll
If you select this check box, the alarm display automatically scrolls the alarm 
list so that the most recent alarm is visible. If you do not select this check box, 
the alarm list does not automatically scroll.

Alarms
This field displays the total number of alarms in the alarm list, based on any 
filters in effect.

Alarm list
The alarm list displays the alarms in the network, based on any filters in 
effect. For each alarm, the list displays information about the severity, event, 
fault code, time, and component.

Detail alarm panel
The detail alarm panel provides tabs that display additional alarm 
information:

Fields tab
The Fields tab displays information about a selected alarm including, the 
following:

• component

• state

• time 

• type

• customer ID

• fault code

• severity 
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• cause

• event

Ack tab
The Ack tab displays the alarm acknowledgement state, the 
acknowledgement user ID, and any alarm acknowledgement comments.

Full tab
The Full tab displays the selected alarm in full format.

Help tab
The Help tab displays help on a selected alarm, including detailed 
information on the alarm and possible remedial action.

Using filters
Using filters is an effective way to refine the display of alarms. MDMWeb 
provides two types of filters–simple and advanced. A simple filter applies to 
a single item, for example a single component or a single fault code. An 
advanced filter applies to multiple items, for example multiple components or 
multiple fault codes. For details, see the following:

• “Using wildcards in filters” (page 56)

• “Simple Filter” (page 57)

• “Advanced filter” (page 58)

Using wildcards in filters
The alarm display application supports the use of wildcards. You can use 
wildcards in the Component ID and Fault Code fields of the simple and 
advanced filter panels. Two wildcard characters are available—the asterisk 
(*) and the questions mark (?). 

The * matches any string, including a null string. For example, if you specify 
a component pattern EM/R* in the Component ID field, the alarm display 
returns alarms for all nodes and their subcomponents that start with EM/R. 
This might include such nodes as EM/R, EM/R1, EM/RWEST, and EM/R01. 
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The ? matches a single character. For example, if you specify a component 
pattern EM/R? in the component ID field, the alarm display returns alarms for 
all nodes and their subcomponents that begin with EM/R and have one 
additional character in their name. This might include such nodes as EM/R0, 
EM/R9, and EM/RW.

Simple Filter
The simple filter panel lets you define a filter based on a single component, a 
single fault code, the date and time, and alarm severity. 

The figure “MDMWeb alarm display with simple filter” (page 57) shows a 
sample alarm display application with a simple filter in effect.

Figure 10
MDMWeb alarm display with simple filter
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The simple filter consists of the following areas:

• Component text field

• Fault Code text field

• Alarms After Date/Time text field (see “Alarm mode” (page 54) for a 
description of the RTAC behaviour when this filter is applied.)

• a series of alarm severity check boxes

• Set button

• Revert button

Where appropriate, select items that you require for your filter. The Set button 
activates the filter. The Revert button clears any filter changes from the time 
Set was last clicked.

Setting a simple filter
1 Define a simple filter by any of the following actions:

• entering a component ID in the Component field

• entering a fault code in the Fault Code fields

• entering date and time information in the Date/Time fields

• selecting any of the alarm severity check boxes

2 Activate the filter by clicking Set.

Advanced filter
The advanced filter panel lets you define a filter based on a multiple 
components, multiple fault codes, the date and time, and alarm severity. The 
customer ID field supports an accept and reject section. If you are picking up 
your alarm history using RTAC, the advanced filter only supports accept. See 
“Alarm mode” (page 54) on a decription of the RTAC behavior when 
applying the Time filter.

The figure “MDMWeb alarm display with advanced filter” (page 59) shows 
a sample alarm display application with advanced filtering in effect. 
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Figure 11
MDMWeb alarm display with advanced filter

The advanced filter also supports rejections. In general, an alarm filter 
displays alarms that pass through the filter. For example, if you set a filter for 
critical severity, only critical alarms display in the alarm list. If you reject a 
filter for critical severity, all alarms except critical display in the alarm list.

The advanced filter consists of the following areas:

• filter list

• filter list buttons Delete and Set
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• filter buttons Accept, Reject, Since, and Before 

• Component ID, Fault, and Time text input fields

• Severity list box

• Customer ID

Setting an advanced filter
1 Define an advanced filter and add that definition to the list of advanced 

filters by any of the following actions:

• enter a component ID in the Component ID fieldand click Accept or 
Reject

• enter a fault code in the Fault field and click Accept or Reject

• enter date and time information in the Date/Time fields and click 
Since or Before

• select any of the alarm severity check boxes and click Accept or 
Reject

• enter a customer ID in the Customer ID field and click Accept

2 To activate the advanced filter, click Set.

Removing a filter from the advanced filter list
1 Select the appropriate entry from the advanced filter list.

2 Click Delete.

3 To activate the change in the filter list, click Set.
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MDMWeb command console

This section describes the MDMWeb command console application and 
contains the following topics:

• “Command console overview” (page 61)

• “Command console window” (page 62)

• “Connection Management window” (page 67)

• “Prefix Editor window” (page 69)

Command console overview
The MDMWeb command console application lets you directly access the 
switching element and its corresponding command set. It provides an 
interactive operator command interface for network control. 

You can send multiple commands to one or more devices at a time. All 
commands, including the user, route and prefix are logged to a file. (See 
“Command area” (page 65) for more information.) 

The connection management feature also lets you log on to a specific group 
of devices or view the list of connected groups.

For details on the Preside Multiservice Data Manager (MDM) command 
console, see 241-6001-804 Preside MDM Workstation Utilities User Guide. 
For a comparison of command console features in MDM and MDMWeb, see 
the table “Comparison of MDM and MDMWeb command console features” 
(page 62).
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Command console window
You access the command console from the System -> Utilities menu in the 
MDMWeb window.

The figure “MDMWeb command console window” (page 63) shows a 
sample command console session.

Table 5
Comparison of MDM and MDMWeb command console features

Feature MDM 
command console

MDMWeb 
command console

Menu bar Yes Yes

Connection management Yes Yes

Save to file Yes Yes

Prefix definition Yes Yes

Route Yes Yes 

Command history Yes Yes
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Figure 12
MDMWeb command console window

The command console window consists of the following areas:

• “Menu bar” (page 63)

• “Command response area” (page 65)

• “Command area” (page 65)

Menu bar
The command console application provides the following menus:

• “File” (page 64)

• “Edit” (page 64)

• “Security” (page 64)

menu bar

command 
response 
area

command 
area
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• “Help” (page 65)

File 
The File menu contains the following commands:

• Save as opens a Java Save dialog and lets you save the command console 
information to a specified file. 

• Load Prefix List opens a Java Open dialog and lets you specify a prefix 
file for use in the command console application.

• Log Session To File opens a Java Save dialog and lets you save the 
command console log session to a specified file.

This command opens or closes a command console log session. To open a log 
session and capture console commands and responses, select the Log Alarms 
To File check box. When you select this command, a Java Open dialog opens 
and prompts you for information on where to store the log file. After the log 
file successfully opens, command console events begin accumulating. To 
close the log session, clear the Log Alarms To File check box.

• Print prints the contents of the command response area. 

• Close closes the command console window and exits the application.

Edit
The Edit menu contains the following command:

• Copy copies the selected text in the display area to the system clipboard. 
Alternatively, you can access the Copy command from a pop-up menu in 
the command response area.

Security 
The Security menu contains the following command:

• Connection Management opens the connection management 
application and lets you connect to or disconnect from network 
destinations. For details, see “Connection Management window” 
(page 67).
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Help 
The Help menu contains the following commands:

• On Command Console opens the help application and displays online 
information about the command console.

• Online Documentation opens the help application for document 
browsing.

Command response area
The command response area displays both the operator command and the 
response to that command. A pop-up menu in this area lets you copy selected 
text into the system clipboard. Command responses may be interspersed 
between other responses and be out of order. Each time a piece of response 
data is displayed, it is preceded by the response’s corresponding request.

Command area
The command area consists of a command history list, a series of option 
boxes, and a command entry area. All commands, including the user, route 
and prefix are logged to the file cclog.yyyymmdd, where yyyymmdd is the 
date on the server when the command is executed. The log files are stored in 
the directory /opt/Nortel/WMS/log.

Command history list
The command history list displays a list of all commands that you enter 
during a session. Each entry in the list has a number, a command status 
indicator, and the command. The command status indicators are as follows: 

• OK for commands that execute successfully

• ERR for commands that fail to execute

• … for any command that is currently processing, regardless of whether 
it is the latest command

You can use this list to execute a command again by double clicking an entry 
in the list.
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Route list box
The Route option lets you define the destination for your commands. To 
access an available node, the MDMWeb client session must connect to the 
destination. See “Security” (page 64), then click the downward pointing 
arrow in the Route box and select an entry from the list.

You can also run MDMWeb server-side scripts from the route list box. The 
scripts must be stored under /opt/Nortel/WMS/scripts or its sub-directory on 
the MDMWeb server. To execute a script, select ‘$’ from the route list box, 
enter the script name on the command line and press Enter. The script’s output 
is displayed in the command response area of the Command Console. An 
error is generated if you have ‘|’, ‘..’ or ‘;’ in the command. If none of these 
errors is found, the command is prefixed by the string /opt/Nortel/WMS/
scripts.

For example, to execute a server-side script ‘whichcurrent’ stored under /opt/
Nortel/WMS/scripts/network_model directory, you must select ‘$’ from the 
route list box. Then enter /network_model/whichcurrent on the command line 
and press Enter.

AutoPrefix check box
If you select this check box, the command console starts automatic prefix 
mode. In automatic prefix mode, the command console converts a previously 
executed command into a device-specific command. The command console 
uses the device for the prefix of the next command. For example, if you 
execute the command noder16 lp/*, the command console enters the 
prefix noder16 in the command entry area as part of the next command. If 
you do not select this command, automatic prefix mode is turned off.

Prefix list box
Depending on the resource file settings, the Prefix field appears as a text field 
where you type an entry or as a combo box where you make a selection from 
a list of prefixes.

Command entry area
Type operator commands in the command area. The results of the command 
displaying the command response area. 

Enter button
As an alternative to pressing the enter key to enter a command, click Enter.
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Connection Management window
The connection management application opens the Connection 
Management window. This window lists available groups in the network 
from which you can connect or disconnect.

You access the connection management window from the System -> 
Administration menu in the MDMWeb window.

The figure “MDMWeb Connection Management window” (page 67) shows a 
sample Group Connection Management window.

Figure 13
MDMWeb Connection Management window

The Connection Management window consists of the following areas:

• “Menu bar” (page 67)

• “Groups list area” (page 68)

• “Authentication area” (page 68)

Menu bar
The Connection Management application provides the following menus:

• “File” (page 68)

menu bar

group 
list area

authentication area
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• “Groups” (page 68)

• “Help” (page 68)

File
The File menu contains the following command:

• Close closes the Connection Management window and exits the 
application.

Groups
The Groups menu contains the following command:

• Reload Group refreshes the group information from the host group 
directory server (HGDS).

Help 
The Help menu contains the following commands:

• On Group Connection opens the help application and displays online 
information about the group connection.

• Online Documentation opens the help application for document 
browsing.

Groups list area
The Groups list area displays the groups in the network that you can access.

Authentication area
The authentication area consists of the User and Password fields, a User List, 
and connection management option buttons.

Type a valid user name and password for the group you select. During a 
session, each time you enter a valid user ID and password, the connection 
management application adds the user ID to the User List. If you later require 
a previously entered user ID and password, you can select the appropriate 
entry from the User List. The connection management application 
automatically updates the User and Password fields. However, for security, 
the password field displays asterisks rather than the actual password. The 
User List remains if effect only while the application is active.
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Option buttons
The connection management option buttons are as follows:

• Connect/Disconnect toggles between connect and disconnect. Use it to 
connect to or disconnect from a group. 

• New Console opens a new command console session.

Prefix Editor window
The prefix editor application lets you load, save, and edit prefix lists for use 
in the command console application. You access the prefix editor from the 
System -> Administration menu in the MDMWeb window. The prefix 
editor application opens the Prefix Editor window.

The figure “MDMWeb Prefix Editor window” (page 69) shows a sample 
Prefix Editor window.

Figure 14
MDMWeb Prefix Editor window

The Prefix Editor window consists of the following areas:

• “Menu bar” (page 70)

• “Prefix field” (page 70)

• “Prefix list” (page 70)

menu bar

prefix field

prefix list
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Menu bar
The prefix editor application provides the following menus:

• “File” (page 70)

• “Help” (page 70)

File
The File menu contains the following commands:

• Open opens a prefix list and displays it in the Prefix Editor window. 
When you select this command, a Java Open dialog opens and prompts 
for the location of the prefix list.

• Save saves the contents of the prefix list to a file. When you select this 
command, a Java Save dialog opens and prompts you for information on 
where to save the prefix list. 

• Close closes the prefix editor application.

Help
The Help menu contains the following commands:

• On Prefix Editor opens the help application and displays online 
information about the prefix editor.

• Online Documentation opens the help application for document 
browsing.

Prefix field
Depending on your setup, the Prefix field may appear as a a text field or as a 
combo box from which you can make a selection. Use the Prefix field to add 
or delete an entry in the prefix list. Type a new prefix name in this field and 
click Add. The new prefix is added to the prefix list.

Prefix list
The prefix list displays the current contents of the prefix file. You can add and 
delete entries from this list. 
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MDMWeb network status

This section describes the MDMWeb network status application and contains 
the following topics:

• “Network status overview” (page 71)

• “Network Status window” (page 72)

Network status overview
The MDMWeb network status application provides a high-level view of the 
current network status. It displays the number of alarms for each severity 
level. 

For details on the Preside Multiservice Data Manager (MDM) network status 
bar, see 241-6001-011 Preside MDM Fault Management User Guide. For a 
comparison of network status features in MDM and MDMWeb, see the table 
“Comparison of MDM and MDMWeb network status features” (page 71).

Table 6
Comparison of MDM and MDMWeb network status features

Feature MDM 
network status

MDMWeb 
network status

Menu bar Yes Yes

Active alarm counts Yes Yes

Refresh Yes Yes

 (Sheet 1 of 2)
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Network Status window
You access the network status application from the Fault menu in the 
MDMWeb window.

The figure “MDMWeb Network Status window” (page 72) shows the 
network status application.

Figure 15
MDMWeb Network Status window

The network status window displays the number of alarms by severity. 
Severity levels include the following: 

• C (critical)

• M (major)

• m (minor)

• W (warning)

Component states Yes Yes

Troubled components Yes Yes

Acknowledge Yes Yes

Table 6 (continued)
Comparison of MDM and MDMWeb network status features

Feature MDM 
network status

MDMWeb 
network status

 (Sheet 2 of 2)
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Each severity is color coded according to the color scheme in effect. You can 
use the Preside Multiservice Data Manager (MDM) or standard color scheme. 
For details, see the table “State color representations for MDM and standard” 
(page 34). In addition to color, each severity level contains an indicator value 
(a value that indicates the number of alarms at that level).

In addition to alarm count by severity, you can display component count by 
state. For details, see “Network status pop-up menu” (page 73).

Network status pop-up menu
A pop-up menu lets you execute commands from the network status 
application. 

The figure “Network status pop-up menu” (page 73) shows the network 
status application and its associated pop-up menu.

Figure 16
Network status pop-up menu

The network status pop-up menu contains the following commands:

• Acknowledge acknowledges the values for each severity level. When 
you select this command, the background color of all severity levels 
changes to gray. However, if any indicator value changes, the background 
color of its severity level reverts to its unacknowledged color.
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• Show Component Counts turns the display of component counts by 
state on or off. To display the number of components by state in the 
network window, select the Show Component Counts check box. The 
status bar application displays the number of components for each of the 
following states:

— OOS (out-of-service)

— ISTB (in-service – troubled

— INSV (in-service)

— UNKN (unknown)

To turn off the display of component counts by state, clear the check box.

• Show Totals turns the display of alarm count and state count totals on or 
off. To turn on the display, select the Show Totals check box. If the 
network status displays only alarm information when you select this 
command, then the following summary alarm information is added to the 
display:

— total number of alarms

— alarm rate

If the network status displays both alarm and component information when 
you select this command, then the following alarm and component summary 
information is added to the display:

— AA totals (total number of active alarms)

— AA rate (active alarm rate)

— Mod (total number of modules being monitored)

— Sub (total number of subcomponents being monitored)

— Links (total number of plain links)

— DBNL (total number of dynamic dial backup network links)
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To turn off the display of state and alarm counts, clear the check box.

• Refresh refreshes the screen by checking for indicator value changes. By 
default, the network status application refreshes every 60 seconds. 
Selecting this command causes an immediate refresh. If any indicator 
value changes, the background color of its severity level reverts to its 
unacknowledged color.

• Beep When Count Changes sets an audible warning when the a current 
indicator value changes. For Windows 2000, Windows NT, or 
Windows XP platforms, you may need to assign a sound to the default 
beep setting in the Sounds control panel. To turn on the beep when counts 
change, select the Beep When Count Changes check box. To turn off the 
beep, clear the check box.

• Help on Network Status displays online information about the network 
status application.

• Online Documentation opens the help application for document 
browsing.
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MDMWeb network browser

This section describes the MDMWeb network browser application and 
contains the following topics:

• “Network browser overview” (page 77)

• “MDMWeb Network Browser window” (page 77)

Network browser overview
The MDMWeb network browser application provides a hierarchical 
representation of the network down to the node level. You can navigate 
through the levels to view the states of modelled objects. 

The MDMWeb network browser does not have a corresponding tool in 
Preside Multiservice Data Manager (MDM). However, the network browser 
has similarities to both the MDM network viewer and the component status 
display. The browser detects state changes in the network model and updates 
the display with new state information on an on-going basis. The network 
browser views network model objects down to the node level. For objects 
below the node level, use the component information viewer application.

For details on the MDM network viewer and MDM component status display, 
see 241-6001-011 Preside MDM Fault Management User Guide.

MDMWeb Network Browser window
You access the network browser application from the Fault menu in the 
MDMWeb window.
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The figure “MDMWeb network browser window” (page 78) shows a sample 
network browser window. 

Figure 17
MDMWeb network browser window

The MDMWeb network browser window displays network model 
components down to the node level. 

Network browser pop-up menu
A pop-up menu lets you execute commands from the network browser 
application. 

The figure “Network browser pop-up menu” (page 79) shows the network 
browser application and its associated pop-up menu.
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Figure 18
Network browser pop-up menu

The network browser pop-up menu contains the following commands:

• Reload Network Model refreshes the network browser, capturing any 
additions or deletions to network model components.

• Launch Alarm Display starts the alarm display application. For details, 
see “MDMWeb alarm display” (page 45).

• Launch Component Information Viewer starts the component 
information viewer application. For details, see “MDMWeb component 
information viewer” (page 81).

• Turn Maintenance State On puts a component in a maintenance state. 
The maintenance state is propagated down to all the component’s 
subcomponents. A component’s state is shown as MTCE. The default 
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color for this state is light blue. The components remain in this state until 
you turn it off. You can also access this command from the state menu in 
the component information viewer.

• Turn Maintenance State Off takes a component out of a maintenance 
state. You can also access this command from the state menu in the 
component information viewer.

• Help on Network Browser displays online information about the 
network browser application.

• Online Documentation opens the help application for document 
browsing.
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MDMWeb component information viewer

This section describes the MDMWeb component information viewer 
application and contains the following topics:

• “Component information viewer overview” (page 81)

• “Component information viewer window” (page 82)

Component information viewer overview
The MDMWeb component information viewer allows you to diagnose 
network faults by viewing state and alarm information for specified 
components, and viewing diagnostics information. Although you can view 
network model objects down to the node level using the network browser, you 
need to use the component information viewer to view objects below the node 
level. The diagnostics section provides you with commands to let you access 
information to assist in the diagnosis of network faults.

For details on the Preside Multiservice Data Manager (MDM) component 
information viewer, see 241-6001-011 Preside MDM Fault Management 
User Guide. For a comparison of component information viewer features in 
MDM and MDMWeb, see the table “Comparison of MDM and MDMWeb 
component information viewer features” (page 82).
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Component information viewer window
You access the component information viewer from the Fault menu in the 
MDMWeb window. The component information viewer contains alarm 
information and diagnostics information that help you diagnose network 
problems. Selecting a window tab displays the applicable information.

The figure “MDMWeb component information viewer window” (page 83) 
shows a sample component information viewer window with the alarm tab 
selected, and the filter panel showing. For more information on the filter 
panel, see “Filter panel area” (page 89).

Table 7
Comparison of MDM and MDMWeb component information viewer features

Feature MDM 
component 
information 
viewer 

MDMWeb 
component 
information 
viewer 

Menu bar Yes Yes

Status for related components Yes Yes

Component filtering Yes Yes

Alarms for related components Yes Yes

Traverse entire model Yes No. Only the 
components related 
to a specific node.
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Figure 19
MDMWeb component information viewer window

The figure “Diagnostics” (page 84) shows a sample component information 
viewer window with diagnostics information showing.

menu bar

filter 
panel 
area

component 
list area

detail alarm panel

alarm list area

filter options
status bar

window tabs
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Figure 20
Diagnostics

The component information viewer window consists of the following areas:

• “Window tabs” (page 85)

• “Menu bar” (page 85)

• “Filter panel area” (page 89)

• “Component list area” (page 90)

• “Filter option boxes” (page 90)

• “Status bar” (page 91)

• “Alarm list area” (page 91) (shown when alarms window tab is selected)

diagnostics area
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• “Detail alarm panel” (page 92) (shown when alarms window tab is 
selected)

• “Diagnostics tab” (page 93) (shown when diagnostics window tab is 
selected)

Window tabs
The component information view has two window tabs: alarms and 
diagnostics. Clicking the alarm tab displays alarm information. Clicking the 
diagnostics tab displays information that will help you diagnose network 
problems. 

Menu bar
The component information viewer provides the following menus:

• “File” (page 85)

• “View” (page 85)

• “Edit” (page 86)

• “Alarms” (page 86)

• “State” (page 88)

• “Help” (page 89)

File
The File menu contains the following commands:

• Reset Server Connections resets the connection to the general 
management data router (GMDR) server. Use this command if the 
GMDR server stops responding to the client, for example, if you set a 
new filter but receive no alarms. 

• Close closes the component information viewer window and exits the 
application.

View
The View menu contains the following command:

• Show Alarm Bubbles changes to display format of alarms. By default, 
the MDMWeb component information viewer application displays 
alarms in Preside Multiservice Data Manager (MDM) format. If you 
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prefer, you can display the alarms using the standard format. The MDM 
format provides a background color for each alarm to indicate alarm 
severity. The standard format uses color-coded alarm bubbles, rather than 
background colors, to indicate alarm severity. Selecting the Show Alarm 
Bubbles command toggles between the two alarm display choices.

Edit
The Edit menu contains the following command:

• Copy Alarm copies the full format of a selected alarm from the alarm 
list to the system clipboard. You can then paste this information into 
another application.

Alarms
The Alarms menu contains the following commands:

• Sort Alarms By Component ID sorts alarms alphabetically by 
component ID. The alarm display sorts only those alarms that are present 
at the time of the sort request. Subsequent alarms appear unsorted at the 
end of the alarm table.

• Sort Alarms By Time sorts alarms by time. The alarm display sorts only 
those alarms that are present at the time of the sort request. Subsequent 
alarms appear unsorted at the end of the alarm table.

• Acknowledge Alarm acknowledges an alarm in the alarm list. When 
you select this command an Input dialog opens and prompts you for an 
acknowledge comment. After you acknowledge an alarm, the application 
displays a check mark icon in the alarm Event field.

• Unacknowledge Alarm unacknowledges an alarm in the alarm list. 
When you select this command an Input dialog opens and prompts you 
for an unacknowledge comment. After you unacknowledge an alarm, the 
application displays a crossed out check mark icon in the alarm Event 
field.

• Show Critical Alarm Highlights turns background color (highlights) on 
or off for critical alarms. To highlight critical alarms, select the Show 
Critical Alarm Highlights check box. In MDM alarm format, rows that 
contain critical alarms display with highlights. In the standard alarm 
format, critical alarm bubbles display with highlights. To turn off critical 
highlights, clear the check box.
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• Show Major Alarm Highlights turns background color (highlights) on 
or off for major alarms. To highlight major alarms, select the Show 
Major Alarm Highlights check box. In MDM alarm format, rows that 
contain major alarms display with highlights. In the standard alarm 
format, major alarm bubbles display with highlights. To turn off major 
highlights, clear the check box.

• Show Minor Alarm Highlights turns background color (highlights) on 
or off for minor alarms. To highlight minor alarms, select the Show 
Minor Alarm Highlights check box. In MDM alarm format, rows that 
contain minor alarms display with highlights. In the standard alarm 
format, minor alarm bubbles display with highlights. To turn off minor 
highlights, clear the check box.

• Show Warning Alarm Highlights turns background color (highlights) 
on or off for warning alarms. To highlight warning alarms, select the 
Show Warning Alarm Highlights check box. In MDM alarm format, 
rows that contain warning alarms display with highlights. In the standard 
alarm format, warning alarm bubbles display with highlights. To turn off 
warning highlights, clear the check box.

• Show Indeterminate Alarm Highlights turns background color 
(highlights) on or off for indeterminate alarms. To highlight 
indeterminate alarms, select the Show Indeterminate Alarm 
Highlights check box. In MDM alarm format, rows that contain 
indeterminate alarms display with highlights. In the standard alarm 
format, indeterminate alarm bubbles display with highlights. To turn off 
indeterminate highlights, clear the check box.

• Show Cleared Alarm Highlights turns background color (highlights) 
on or off for cleared alarms. To highlight cleared alarms, select the Show 
Cleared Alarm Highlights check box. In MDM alarm format, rows that 
contain cleared alarms display with highlights. In the standard alarm 
format, cleared alarm bubbles display with highlights. To turn off cleared 
highlights, clear the check box.

• Critical Bell turns sound effects on or off for critical alarms. Use this 
command only if your resource file has sound definitions and your 
hardware supports sound. To play a sound whenever the alarm display 
receives a critical alarm, select the Critical Bell check box. To turn off 
sounds for critical alarms, clear the check box.
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• Major Bell turns sound effects on or off for major alarms. Use this 
command only if your resource file has sound definitions and your 
hardware supports sound. To play a sound whenever the alarm display 
receives a major alarm, select the Major Bell check box. To turn off 
sounds for major alarms, clear the check box.

• Minor Bell turns sound effects on or off for minor alarms. Use this 
command only if your resource file has sound definitions and your 
hardware supports sound. To play a sound whenever the alarm display 
receives a minor alarm, select the Minor Bell check box. To turn off 
sounds for minor alarms, clear the check box.

• Warning Bell turns sound effects on or off for warning alarms. Use this 
command only if your resource file has sound definitions and your 
hardware supports sound. To play a sound whenever the alarm display 
receives a warning alarm, select the Warning Bell check box. To turn off 
sounds for warning alarms, clear the check box.

State
The State menu contains the following commands:

• Turn Acknowledgement State On puts a component in an 
acknowledged state. The acknowledged state is propagated up to all the 
component’s subcomponents. A component’s state is shown as ACKED. 
The default color for this state is cyan. The component remains in this 
state until you turn it off or until the component’s state changes.

• Turn Acknowledgement State Off takes a component out of an 
acknowledged state.

• Turn Maintenance State On puts a component in a maintenance state. 
The maintenance state is propagated down to all the component’s 
subcomponents. A component’s state is shown as MTCE. The default 
color for this state is light blue. The components remain in this state until 
you turn it off. You can also access this command from the network 
browser’s pop-up menu. 

• Turn Maintenance State Off takes a component out of a maintenance 
state. You can also access this command from the network browser’s 
pop-up menu. 

Note: The menu items which appear depend on the state of the currently 
selected component.
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Help
The Help menu contains the following commands:

• On Component Information Viewer displays online information about 
the component information viewer application.

• Online Documentation opens the help application for document 
browsing.

Filter panel area
The Filter panel area is where you can use filters to display different alarm 
information. By default, the filter panel is hidden. However, the component 
information viewer contains a Propagated State/Criticality button that lets 
you control the filter panel display. You can filter the components based on 
their state or threshold value.

The Component Information Viewer supports filtering on the following 
conditions:

• Troubled Network State

• Propogated State/Criticality

The Troubled Network State filter only displays components that have a 
troubled raw state display. Troubled raw states include out-of-service (OOS) 
and in-service troubled (ISTB). Filtering on Propagated State/Criticality 
lets you select the specific propagated states and state critcalities that you 
wish to display.

State filter options
To filter by state, select from the following options:

• OOS (out of service)

• ISTB (in service, troubled)

• INSV (in service)

• Unknown
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Threshold filter options
To filter the components based on their threshold, select any of the values 
from 1 to 5. The more outages a component’s fault causes, the higher its 
threshold value. If you filter on INSV or Unknown states, any selected 
threshold values are ignored.

Set Filter button
The Set Filter button activates any selected state and threshold filters.

Component list area
The component list area is where you can request a component to view. The 
area contains a Component field and Enter button, component list box, and 
component list options boxes.

Component field
The Component field lets you enter the name of the node that you want to 
view. 

Enter button
As an alternative to pressing the enter  key to enter a a component ID in the 
component field, click Enter.

Component list box
After you enter a component ID, a component list opens. This list shows all 
the related components including parents and children.

Filter option boxes
The filter option boxes let you turn hot context on or off and to set an auto- 
refresh interval.

Hot Context
If you select this check box, hot context is turned on. If you do not select this 
check box, hot context is turned off. For information on hot context, see “Hot 
context” (page 43).

Auto-Refresh
This option refreshes (reloads) the network model information. The 
component information viewer application does not update network model 
information as the network status changes. You need to reload model 
information to capture state changes. If you select this check box, the 
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applications reload based on the time specified in the Interval field. If you do 
not select this check box, the application does not reload network model 
information.

Interval
This option specifies the number of seconds between automatic network 
model reloads. The default value is 60 seconds. When you change the interval 
value and then press the enter key, an immediate refresh occurs. To set an 
interval, ensure that you also select the auto-refresh check box. The 
component information viewer does not accept a refresh interval less than 15 
seconds.

Status bar
The status bar provides information about whether filtering is on or off, the 
login user ID, and the server being accessed.

Alarm list area
The alarm list area consists of a list box and check boxes that let you 
determine what displays in the alarm list, an alarm count, and a detailed alarm 
list.

Note: The alarm list area information is displayed when the alarms 
window tab is selected.

Alarm mode
This list box provides lets you choose from the following alarm modes. 

— Active Alarms display only active alarms.

— Alarm Log displays recent alarms as they are received by Preside 
Multiservice Data Manager (MDM). This mode includes all alarms 
including set, clear, and message events

— Alarm History is similar to Alarm Log but also includes past 
alarms. In some networks, selecting this mode can result in large 
amounts of alarm data.

Pause Alarms
If you select this check box, no subsequent alarms display in the alarm list. If 
you do not select this check box, the alarm display continues to add alarms to 
the alarm list. 
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Auto-scroll
If you select this check box, the alarm display automatically scrolls the alarm 
list so that the most recent alarm is visible. If you do not select this check box, 
the alarm list does not automatically scroll.

Detail alarm panel
The detail alarm panel provides tabs that contain additional alarm 
information.

Note: The alarm list area information is displayed when the alarms 
window tab is selected.

Fields tab
The Fields tab displays information about a selected alarm, including the 
following:

• Component

• State

• Time 

• Type

• Customer ID

• Fault

• Severity 

• Cause

• Event

Ack tab
The Ack tab displays the alarm acknowledgement state, the 
acknowledgement user ID, and any alarm acknowledgement comments.

Full tab
The Full tab displays the selected alarm in full format.

Help tab
The Help tab displays help on a selected alarm, including detailed 
information on the alarm and possible remedial action.
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Diagnostics tab
Diagnostics information is displayed when the diagnostics window tab is 
selected.The diagnostics window consists of the following:

• security tab

• route box

• commands menu

• command output area

• related component list

Security tab
To run diagnostics on a device, you must first authenticate with the device. 
Selecting the security tab opens the Connection Management window. When 
you have authenticated with a device, the diagnostics information is 
displayed. For more information on authentication, see “Authentication area” 
(page 68). For more information on the Connection Management window, 
see “Connection Management window” (page 67).

Route box
When a group is authenticated, it is displayed in the route box. When the 
group is selected as a route, you can issue a command to the device.

Command menu
The command menu contains a pulldown listing of commands that you can 
execute on a component. You can execute one command at a time. For more 
information on the default commands, see the section on Component 
Information Viewer diagnostics in 241-6001-011 Preside MDM Fault 
Management User Guide.

Command output area
When you send a command, the response is displayed in the command output 
area of the diagnostics window. The output gives you additional information 
to help you diagnose network problems. The text is refreshed each time a 
command is selected.
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Related component list
The diagnostics related component list area contains a listing of components 
that are related to the network problem. You can select components in this list, 
and run commands to help you determine which component is responsible for 
the network problem.
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Chapter 9
Troubled components

This section describes the MDMWeb’s troubled components application and 
includes the following topics:

• “Troubled components overview” (page 95)

• “Troubled components window” (page 96)

Troubled components overview
The MDMWeb troubled components application displays troubled 
components and links in the network. It helps you determine which devices 
and subcomponents are experiencing problems. The troubled components 
application is most useful when you use it with the network status bar. For 
more information on the troubled components window, see “Troubled 
components window” (page 96).

The table “Comparison of MDM and MDMWeb troubled component 
features” (page 96) compares the troubled component status features in 
Preside Multiservice Data Manager (MDM) and MDMWeb.

For details on the Preside Multiservice Data Manager (MDM) troubled 
components, see 241-6001-011 Preside MDM Fault Management User 
Guide.
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Troubled components window
You access the troubled components application from the Fault menu in the 
MDMWeb window or the network status application’s pop-up menu.

The figure “MDMWeb Troubled Components window” (page 96) shows the 
troubled components application.

Figure 21
MDMWeb Troubled Components window

Table 8
Comparison of MDM and MDMWeb troubled component features

Feature MDM 
troubled 
components

MDMWeb 
troubled 
components

Menu bar No Yes

Accessible from network status Yes Yes

Accessible from fault menu No Yes
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The troubled components window consists of the following areas:

• “Menu bar” (page 97)

• “Troubled components list” (page 97)

• “Menu bar” (page 97)

• “Troubled subcomponents list” (page 98)

• “Component text box” (page 98)

• “Buttons” (page 98)

Menu bar
The troubled components application consists of the following menu items:

• “File” (page 97)

• “Help” (page 97)

File
The File menu contains the following commands:

• Refresh reloads the information in the troubled components list, and 
clears the troubled subcomponents list.

• Close closes the troubled components window and exits the application.

Help
The Help menu contains the following commands:

• On Troubled Components opens the help application and displays 
online information about the troubled components application.

• Online Documentation opens the help application for document 
browsing.

Troubled components list
The troubled components list displays every device that contains a troubled 
subcomponent or link. When an element is selected from the troubled 
components list, the troubled subcomponents list shows the subcomponents 
or links of the selected component which are in a troubled state.
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Note: The information displayed in the troubled components list is static. 
Select Refresh to display new troubled components.

Troubled subcomponents list
Initially, the troubled subcomponents list is empty. Information is displayed 
in this list when a component or link is selected from the troubled components 
list.

Component text box
The component text box displays any list selection made, regardless of which 
list the selection was made from. You can also edit the component text box to 
any value. 

Buttons
The troubled components application contains the following buttons:

•  Find searches the troubled components list for the component or link 
displayed in the component text box. If the component is found, it is 
selected in the troubled components list.

•  Get Context sets the MDMWeb desktop’s current context to be the 
value of the component text box.

•  Put Context sets the component text box to be the MDMWeb desktop’s 
current context.
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Chapter 10
MDMWeb error messages

This section contains information to help you detect and solve problems with 
MDMWeb. It contains information on problems and corrective measures.

Table 9
MDMWeb error messages

Message Details Remedial action

A noninteger value was entered in 
the refresh interval field. Using the 
current refresh interval instead.

The value entered in the 
component information 
viewer interval field is not an 
integer. 

Ensure that the value in the 
integer field is an integer.

Alarm already acknowledged. The alarm you are trying to 
acknowledge is already 
acknowledged.

Ensure that the correct alarm 
has been selected for 
acknowledgement.

Alarm is not acknowledged. An attempt has been made 
to unacknowledge an alarm 
that has not been 
acknowledged. 

Ensure that the correct alarm 
has been selected for 
unacknowledgement. 

Connect/DIsconnect in progress. While one group is currently 
connecting or disconnecting, 
any other requests for group 
connections or 
disconnections do not 
execute. 

Wait until the current connect 
or disconnect operations 
complete before requesting 
another connect or disconnect. 

 (Sheet 1 of 7)
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Customer ID must be an integer The advanced filter cannot 
accept a value other than an 
integer.

Add a valid customer ID.

Enter a prefix before adding it to 
the prefix list.

An attempt has been made 
to add a prefix without first 
entering it in the prefix field.

In the Prefix Editor application, 
enter a prefix in the prefix field 
to add an entry in the prefix list.

Invalid customer ID filter. The advanced filter cannot 
accept a null customer ID 
filter.

Add a valid customer ID.

Invalid user name or password. The authentication process 
detects an invalid user name 
or password, or both.

Use a valid user name and 
password.

Invalid time filter. Format is 
“yyyy/mm/dd hh:mm:ss.”

MDMWeb cannot parse the 
time passed in the Alarm 
Display advanced filter time 
field. 

Use the specified time format.

No APP appname defined in 
resource file.

There are serious problems 
with the resource file.

Fix any problems with the 
resource file. Revert to your 
backup file, if necessary.

No SERVERHOST defined in 
resource file.

The SERVERHOST field in 
the resource file SYSTEM 
block is not specified. 
Without a defined 
SERVERHOST, the 
MDMWeb client cannot 
determine the machine to 
use as a server.

Edit the resource file to add an 
entry in the SYSTEM block that 
defines the SERVERHOST.

Table 9 (continued)
MDMWeb error messages

Message Details Remedial action

 (Sheet 2 of 7)
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Resource file must be updated 
with server host information 
before MDMWeb can run.

The SERVERHOST field in 
the resource file SYSTEM 
block has not been updated 
from its original value of 
“host name”.

Edit the resource file and 
specify an appropriate value 
for SERVERHOST.

Restarting Command Console 
server connection.

The connection to the 
command console server 
has been terminated. 
MDMWeb tries to reconnect 
to the server. This 
reconnection can take 
several seconds. If the 
reconnection attempt 
exceeds 15 seconds, there 
is likely a problem with the 
psvagent process or one of 
the command console 
servers. 

None.

Select a filter to be deleted. No filter has been selected 
from the alarm display 
advanced filter.

Select a filter first, then click the 
Delete button.

Select a group before 
authenticating

A group was not selected 
when processing the 
authentication for the group 
connection.

Select a group, and then 
authenticate.

Select a prefix before removing it. There is no prefix displayed 
in the window. 

Ensure prefix information 
displays in the window before 
attempting to save it.

Server authentication failed. It 
appears the authentication 
information used by the agent has 
changed. Try restarting the 
MDMWeb client.

The authentication message 
used is not valid.

Restart MDMWeb with a valid 
userID and password.

Table 9 (continued)
MDMWeb error messages

Message Details Remedial action
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Specify filters without rejection. 
Rtacagent doesn’t support filter 
rejection.

The alarm history mode 
using the rtacagent does not 
support filter rejection.

Set a filter without rejection.

The Troubled Components app 
lost its connection to the server. 
Try resetting the server 
connection.

The server connection is 
lost.

Reconnect to the server.

Unable to close a session to a 
server.

A server connection cannot 
be closed. There is likely a 
problem with an agent or 
with one of the servers with 
which the agent 
communicates.

Verify that the agent and 
servers are running.

Unable to connect to group. The Group Connection 
Management application 
cannot connect to a group. 
The user name or password 
used to authenticate the 
group is not valid or the 
device is refusing the 
connection.

Ensure the user name and 
password used for 
authentication are valid. 

Unable to connect to the server. 
Make sure the server is running 
and is using the proper port.

The server is not up, or you 
are using the wrong port to 
connect to the server.

Try to reconnect.

Unable to copy alarm. An alarm must be selected 
from the alarm table before it 
can be copied.

Select an alarm first, then copy 
the alarm information to the 
clipboard

Table 9 (continued)
MDMWeb error messages

Message Details Remedial action
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Unable to disconnect from group. The Group Connection 
Management application 
cannot disconnect from a 
group. There is a problem 
with the command console 
server.

Check the command console 
server.

Unable to find resources to create 
toolbar.

There are serious problems 
with the resource file.

Fix any problems with the 
resource file. Revert to your 
backup file, if necessary.

Unable to get alarm stream from 
GMDR. Retrying.

The alarm display cannot 
connect to the GMDR 
server. Since the alarm 
display requires a 
connection to GMDR, it 
continues its attempt to 
connect to GMDR until a 
successful connection is 
made.

None.

Unable to launch apps until 
logged in.

The desktop is not 
authenticated. No 
applications can launch until 
authentication occurs.

Log in to MDMWeb.

Unable to launch image from 
filename.

The specified image cannot 
be located. The image file is 
missing or there are 
problems with the resource 
file.

Check for the existence of the 
image file. Fix any problems 
with the resource file.

Unable to load alarm filter. FIle not 
an alarm filter.

The specified file is not a 
valid alarm filter file. 

Correct the entry for the alarm 
filter file.

Table 9 (continued)
MDMWeb error messages

Message Details Remedial action
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Unable to make a connection to 
the servername server.

A connection to the server 
cannot be made. 

Verify that the resource file 
SERVERHOST field is 
appropriately set. Verify that 
the agents are running on the 
server. Verify that the server 
agent ports correspond with 
the port setting in the client 
resource file. 

Unable to open file filename. The specified file cannot be 
opened. The file is missing 
or there is a problem with the 
resource file. 

Check for the existence of the 
file. Fix any problems with the 
resource file.

Unable to open resource file 
filename. 

The resource file cannot be 
opened. The resource file is 
missing or there are 
problems with the resource 
file. 

Check for the existence of the 
resource in the cfg directory. 
Ensure that the resource file 
has the correct file name. Fix 
any problems with the resource 
file.

Unable to open session to server 
for user username.

The session to a server 
cannot be opened. The user 
name or password used is 
not be valid or the agent is 
not able to communicate 
with the required server.

Ensure the user name and 
password used are valid. Verify 
that the agent and server are 
running.

Unable to save alarm filter. No 
alarm filter is currently displayed. 

There is no alarm filter 
displayed in the window.

Ensure alarm filter information 
displays in the window before 
attempting to save it.

Table 9 (continued)
MDMWeb error messages

Message Details Remedial action
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Unable to save data to file 
filename. 

The specified file cannot be 
saved. It is likely that write 
permissions to this file are 
not set.

Verify that the UNIX file 
permissions allow write 
access.

Unable to send request to server. A server cannot accept a 
request. There is likely a 
serious problem with the 
server.

Verify the server and agents 
are running.

Table 9 (continued)
MDMWeb error messages

Message Details Remedial action
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Appendix A
Engineering Information

This section provides engineering information for MDMWeb and contains 
the following topics: 

• “Resource requirements” (page 107)

• “Communication requirements” (page 108)

• “MDMWeb performance” (page 108)

Resource requirements
Resource requirements are as follows:

• MDMWeb server supports a maximum of 10 clients.

• MDMWeb server minimum requirements are as follows:

— a Sun Ultra 10 Workstation

— 128 Mbyte RAM

— 2 Gbyte hard disk

• MDMWeb client minimum requirements are as follows:

— for Solaris, Sun Ultra 1 or Ultra 10 workstation with 256 Mbyte 
RAM

— for Windows 2000, 128 Mbyte RAM

— for Windows NT, 128 Mbyte RAM 

— for Windows XP, 128 Mbyte RAM
Preside MDM MDMWeb User Guide   14.3RSUP



108   Appendix A Engineering Information
Communication requirements
The communication requirements are as follows:

• TCP/IP based socket communication between MDMWeb server and 
MDMWeb client

• TCP/IP based IPI protocol between MDMWeb server and Preside 
Multiservice Data Manager (MDM) server

MDMWeb performance
MDMWeb clients are expected to have similar performance to current Xterm-
based clients from the MDM server workstation.
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Index
A
accessing MDMWeb 19
acknowledging alarms

alarm display 51
component information viewer 86

advanced filter 50, 58–60
setting 60

alarm bubbles
alarm display 49
component information viewer 85

alarm display 17, 45–60
accessing 46
acknowledging alarms 51
active mode 45
alarm bubbles 49
filter controls 45
filters

advanced 50, 58–60
simple 50, 57–58

full format 45
highlighting alarms 51–52
INM format 49, 85
log mode 45
log session 48
logging to a file 42
MDM format 49, 85
obtaining alarms from GMDR server 54
obtaining alarms from RTAC tool 54
resetting server connection 48
See also color scheme
setting alarm bells 50–52
sorting 50
unacknowledging alarms 51

application
network browser 18

applications
alarm display 17, 45–60
command console 17, 61–70
component information viewer 18, 81–94
connection management 18, 67–69
connection management, starting 35
login 17, 30
network browser 77–80
network status 18, 71–75
prefix editor 18
prefix editor, starting 35
server status display 18
server status display, starting 34, 37
system log display 17
system log display, starting 35, 41
troubled components 18, 95–98

authentication 31, 68
automatic prefix 66

C
client application

Solaris, starting 28
Windows, starting 29

client platforms 18
color scheme
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customizing 25, 33
INM 33
MDM 33

command console 17, 61–70
accessing 62
logging commands 65
logging to file 64
opening new session 69
prefix list 64
routes 66

commands 93
commands, invisible desktop 24
commands, logging 65
component information viewer 18, 81–94

accessing 82
acknowledging alarms 86
alarm bubbles 85
commands 93
diagnostics 82, 93–94
highlighting alarms 86–87
refresh interval 91
resetting server connections 85
setting alarm bells 87–88
sorting alarms 86
state menu 88
turning acknowledge state off from 88
turning acknowledge state on from 88
turning acknowledgement state on from 88
turning maintenance state on from 88
unacknowledging alarms 86

connection management
starting 35, 42
starting from command console 64

customizing
color scheme 25, 33
desktop 24
look and feel 25, 33

D
deployment options 19
desktop
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error messages 99–105

F
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advanced 50, 58–60
setting 60
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setting 58

H
highlighting alarms

alarm display 51–52
component information viewer 86–87

hot context 43
in alarm display 53
in component information viewer 90

I
icon bar 35
intranet access 19
invisible desktop commands 24

L
log session

command console 64
login application 17, 30
look and feel
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MDMWeb 15
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error messages 99–105
icon bar 35
supported devices 15–??
troubleshooting 99–105

mouse buttons, default settings 14

N
network browser 18, 77–80

accessing 77
starting alarm display from 79
starting component information viewer 

from 79
turning maintenance state off from 80
turning maintenance state on from 79

network partitioning 20, 27
network status 18, 71–75

accessing 72
displaying state counts 74
displaying totals 74
See also color scheme
setting refresh interval 75

O
online documentation 18

P
partitioning the network 20, 27
prefix

automatic 66
prefix editor 18, 69–70
prefix editor application

starting 35
prefix list 64

S
server fields 39
server host

specifying 31
server states 39
server status display 18

server fields 39
server states 39
server status display application

starting 34, 37
setting alarm bells

component information viewer 87–88
in alarm display 50–52

simple filter 50, 57–58
simple filters

setting 58
Solaris client application

starting 28
sorting alarms 86
system log display application 17

starting 35, 41

T
troubled components 18, 95–98

accessing 96
troubleshooting 99–105
turning acknowledge state off 88
turning acknowledgement state on 88
turning maintenance state off 80, 88
turning maintenance state on 79, 88

U
unacknowledging alarms

alarm display 51
component information viewer 86

W
Windows client application, starting 29
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